SOLIDWORKS® 2017
Basic Tools
Getting Started with Parts, Assemblies and Drawings

Paul Tran CSWE, CSWI
Visit the following websites to learn more about this book:
Upon successful completion of this lesson, you will be able to:

* Sketch on planes and/or planar surfaces.
* Use the sketch tools to construct geometry.
* Add the geometric relations or constraints.
* Add/modify dimensions.
* Explore the different extrude options.

The following 5 basic steps will be demonstrated throughout this exercise:

* Select the sketch plane.
* Activate Sketch pencil.
* Sketch the profile using the sketch tools.
* Define the profile with dimensions or relations.
* Extrude the profile.

Be sure to review the self-test questionnaires at the end of the lesson, prior to moving to the next chapter.
Basic Solid Modeling
Extrude Options

View Orientation Hot Keys:
Ctrl + 1 = Front View
Ctrl + 2 = Back View
Ctrl + 3 = Left View
Ctrl + 4 = Right View
Ctrl + 5 = Top View
Ctrl + 6 = Bottom View
Ctrl + 7 = Isometric View
Ctrl + 8 = Normal To
Selection

Dimensioning Standards: ANSI
Units: INCHES – 3 Decimals

Tools Needed:

- Insert Sketch
- Line
- Circle
- Add Geometric Relations
- Dimension
- Sketch Fillet
- Trim Entities
- Boss / Base
- Extrude
1. Starting a new Part:

- From the File menu, select New / Part, or click the New icon.

- Select the Part template from either the Templates or Tutorial folders.

- Click OK; a new part template is opened.
2. Changing the Scene:

- From the View (Heads-up) toolbar, click the Apply Scene button (arrow) and select the **Plain White** option (arrow).

- By changing the scene color to Plain White we can better see the colors of the sketch entities and their dimensions.

- To show the **Origin**, click the **View** dropdown menu and select **Origins**.

- The **Blue Origin** is the **Zero position** of the part and the **Red Origin** is the **Zero position** of a sketch.
3. Starting a new Sketch:

- Select the Front plane from the Feature-Manager tree and click the Pencil icon to start a new sketch.

- A sketch is normally created first, relations and dimensions are added after, and then it gets extruded into a 3D feature.

- From the Command-Manager toolbar, select the Line command.

**OPTION:** Right-Drag to display the Mouse Gesture guide and select the Line command from it. (See the Introduction section, page XVIII for details on customizing the Mouse Gesture.)

- Hover the mouse cursor over the Origin point; a yellow feedback symbol appears to indicate a relation (Coincident) is going to be added automatically to the 1st endpoint of the line. This endpoint will be locked at the zero position.
4. Using the Click + Hold + Drag technique:

- Click at the Origin point and hold the mouse button to start the line at point 1, 
  **drag upwards** to point 2, then release the mouse button.

![Diagram of a line starting at Point 1 and ending at Point 2]

- Continue adding other lines using the **Click-Hold-Drag** technique.

- The relations like Horizontal and Vertical are added automatically to each sketch line. Other relations like Collinear and Equal are added manually.

- The size and shape of the profile will be corrected in the next few steps.

**The Base Sketch**

The Base Sketch is the parent sketch of a part and is also the very first sketch in a part document. It should primarily describe the basic shape of the part before other features can be added.

**System Feedback**

While sketching the lines, watch for the System Feedback Symbols such as ![Icon for Horizontal] for Horizontal, and ![Icon for Vertical] for Vertical Auto Relations.
5. Adding Geometric Relations*:

- Click Add Relation under Display/Delete Relations - OR - select Tools / Relations / Add.

- Select the 4 lines shown below.

- Click Equal from the Add Geometric Relation dialog box. This relation makes the length of the two selected lines equal.

* Geometric relations are one of the most powerful features in SOLIDWORKS. They’re used in the sketch level to control the behaviors of the sketch entities when they are moved or rotated and to keep the associations between one another.

When applying geometric relations between entities, one of them should be a 2D entity and the other can either be a 2D sketch entity or a model edge, a plane, an axis, or a curve, etc.

Equal Relations

Adding the EQUAL relations to these lines eliminates the need to dimension each line.

Geometric relations can be created manually or automatically. The next few steps in this chapter will demonstrate how geometric relations are added manually.

Select the top 4 lines and click Equal relation.

The top 4 lines are now Equal in size.
6. Adding a Collinear relation**:

- Select the Add Relation command again.

- Select the 3 lines as shown below.

- Click Collinear from the Add Geometric Relations dialog box.

- Click OK.

** Collinear relations can be used to constrain the geometry as follows:

- Collinear between a line and another line(s) (2D and 2D).

- Collinear between a line(s) to a linear edge of a model (2D and 3D).
Geometric Relations Examples

- **Coincident**: An endpoint is coincident with a line.
- **Midpoint**: An endpoint is coincident with a midpoint of a line.
- **Tangent**: An arc is tangent with a line or another arc.
- **Concentric**: Two circles are sharing the same center.
- **Equal**: Two circles or two lines having the same size.
- **Collinear**: Two or more points are aligned horizontally.
- **Vertical**: Two or more points are aligned vertically.
- **Horizontal**: Two or more lines are on the same level (or co-planar).
7. Adding the horizontal dimensions:

- Select from the Sketch toolbar - OR - select **Insert / Dimension**, and add the dimensions shown below (follow the 3 steps A, B and C).

A. Click line 1

B. Click line 2

C. Place the dimension approximately here, type **.500** and press enter.

- The Inch-Units is filled in automatically because it has been set previously to Inches, 3 decimal places.

- Continue adding the horizontal dimensions as shown here.

**NOTE:**
The color of the sketch lines changes from Blue to Black, to indicate that they have been constrained with dimensions.
8. Adding the Vertical dimensions:

- With the SmartDimension tool still selected, click on line 1 and line 2; place the dimension approximately as shown, and change the value to **.500 in.**

- Continue adding other dimensions until the entire sketch turns into the Black color.

**The Status of a Sketch:**

The current status of a sketch is displayed in the lower right corner of the screen.

<table>
<thead>
<tr>
<th>Status</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fully Defined</td>
<td>Black</td>
</tr>
<tr>
<td>Under Defined</td>
<td>Blue</td>
</tr>
<tr>
<td>Over Defined</td>
<td>Red</td>
</tr>
</tbody>
</table>
9. Hiding the Sketch Relation Symbols:

- The Sketch Relation Symbols indicates which geometric relation a sketch entity has, but they get quite busy as shown.

- To hide or show the Sketch Relation Symbols, go to the View menu and Click off the Sketch Relations option.

**Sketch Relation Symbols at a Glance**
- Horizontal relation
- Vertical relation
- Equal relation
- Coincident relation
- Tangent relation
- Collinear relation
10. Extruding the Base:

- The **Extrude Boss/Base** command is used to define the characteristic of a 3D linear feature.

- Click \[\text{Extruded Boss/Base}\] from the Features toolbar OR select **Insert / Boss Base / Extrude**.

- Set the following:
  - **Direction**: Blind.
  - **Depth**: 6.00 in.
  - Enabled **Reverse** direction.

- Click **OK**.

---

**SOLIDWORKS 2017 | Basic Tools | Basic Solid Modeling – Extrude Options**
11. Sketching on a Planar Face:

- Select the face as indicated.
- Click or select **Insert/Sketch** and press the shortcut keys Ctrl+7 to change to the Isometric view.
- Select the **Circle** command from the Sketch Tools toolbar.

- Position the mouse cursor near the center of the selected face, and click and drag outward to draw a circle.
- While sketching the circle, the system displays the radius value next to the mouse cursor.
- Dimensions are added after the profile is created.
- Select the **Smart Dimension** command and add a diameter dimension to the circle.

(Click on the circle and move the mouse cursor outward at approximately 45 degrees, and place the dimension).

- To add the location dimensions click the edge of the circle and the edge of the model, place the dimension, then correct the value.

- Continue adding the location dimensions as shown to fully define the sketch.

- Select the Line command and sketch the 3 lines as shown below. Snap to the hidden edge of the model when it lights up.

- The color of the sketch should change to black at this point (Fully Defined).
12. Using the Trim Entities command:

- Select the Trim Entities command from the Sketch toolbar (arrow).

- Click the Trim to Closest option (arrow). When the pointer is hovered over the entities, this trim command highlights the entities prior to trimming to the next intersection.

- Hover the pointer over the lower portion of the circle, the portion that is going to be trimmed-off lights up. Click the mouse button to trim.

- The bottom portion of the circle is trimmed, leaving the sketch as one-continuous-closed-profile, suitable to extrude into a feature.

- Next, we are going to look at some of the extrude options available in SOLIDWORKS.
13. Extruding a Boss:

- Switch to the Feature toolbar and click or select: Insert / Boss-Base / Extrude.

**Using the Blind option:**

- When extruding with the Blind option, the following conditions are required:
  * Direction
  * Depth dimension

- Drag the direction arrow on the preview graphics to define the direction, then enter a dimension for the extrude depth.

**Using the Through All option:**

- When the Through All option is selected, the system automatically extrudes the sketch to the length of the part, normal to the sketch plane.
Using the Up To Next option:
- With the Up To Next option selected, the system extrudes the sketch to the very next set of surface(s), and blends it to match.

Using the Up To Vertex option:
- This option extrudes the sketch from its plane to a vertex, specified by the user, to define its depth.

Using the Up To Surface option:
- This option extrudes the sketch from its plane to a single surface, to define its depth.
F Using the Offset From Surface option:

- This option extrudes the sketch from its plane to a selected face, then offsets at a specified distance.

G Using the Up To Body option:

- This option extrudes the sketch from its sketch plane to a specified body.

- The Up To Body option can also be used in assemblies or multi-body parts.

- The Up To Body option works with either a solid body or a surface body.

- It is also useful when making extrusions in an assembly to extend a sketch to an uneven surface.
Using the Mid Plane option:

- This option extrudes the sketch from its plane equally in both directions.
- Enter the Total Depth dimension when using the Mid-Plane option.

- After you are done exploring all the extrude options, change the final condition to Through All.

- Click OK.

- The system extrudes the circle to the outermost surface as the result of the Through All end condition.
- The overlapped material between the first and the second extruded features is removed automatically.

- Unless the Merge Result checkbox is cleared, all interferences will be detected and removed.

**Extrude summary:**

* The Extrude Boss/Base command is used to add thickness to a sketch and to define the characteristic of a 3D feature.

* A sketch can be extruded in both directions at the same time, from its sketch plane.

* A sketch can also be extruded as a solid or a thin feature.
14. Adding the model fillets by Lasso*:

- Fillet/Round creates a rounded internal or external face on the part. You can fillet all edges of a face, select sets of faces, edges, or edge loops.

- The **radius** value stays in effect until you change it. Therefore, you can select any number of edges or faces in the same operation.

- Click  or select **Insert / Features / Fillet/Round**.

- Select the **Constant Size Fillet** button (Arrow).

- Either "drag-select" to highlight all edges of the model or press the shortcut key **Control+A** (select all).

- Enter **.125 in.** for radius size.

- Enable the **Full Preview** checkbox.

- Click **OK**.
* In the Training Files folder, in the Built Parts folder you will also find copies of the parts, assemblies, and drawings that were created for cross referencing or reviewing purposes.

**Fillets and Rounds:**

Using the same Fillet command, SOLIDWORKS "knows" whether to add material (Fillet) or remove material (Round) to the faces adjacent to the selected edge.

15. Saving your work:

- Select File / Save As.
- Change the file type to Part file (.sldprt).
- Enter Extrude Options for the name of the file.
- Click Save.
Questions for Review

1. To open a new sketch, first you must select a plane from the FeatureManager tree.
   a. True
   b. False

2. Geometric relations can be used only in the assembly environments.
   a. True
   b. False

3. The current status of a sketch is displayed in the lower right area of the screen as
   Under defined, Fully defined, or Over defined.
   a. True
   b. False

4. Once a feature is extruded, its extrude direction cannot be changed.
   a. True
   b. False

5. A planar face can also be used as a sketch plane.
   a. True
   b. False

6. The Equal relation only works for Lines, not Circles or Arcs.
   a. True
   b. False

7. After a dimension is created, its value cannot be changed.
   a. True
   b. False

8. When the UP TO SURFACE option is selected, you have to choose a surface as an end-
   condition to extrude up to.
   a. True
   b. False

9. UP TO VERTEX is not a valid Extrude option.
   a. True
   b. False
Using the Search Commands:

The Search Commands lets you find and run commands from SOLIDWORKS Search or locate commands in the user interface.

These features make it easy to find and run any SOLIDWORKS command:

- The results are filtered as you type and typically find the command you need within a few keystrokes.

- When you run a command from the results list for a query, Search Commands remembers that command and places it at the top of the results list when you type the same query again.

- Search shortcuts let you assign simple and familiar keystroke sequences to commands you use regularly.

- Click the drop down arrow to see the search options (arrow).
1. Search Commands in Features Mode:

- The example below shows how you might use Search Commands to find and run the Lasso Selection command in the Feature Mode.

- With the part still open, start typing the command Lasso Selection in Search Commands. As soon as you type the first few letters of the word Lasso, the results list displays only those commands that include the character sequence "lasso," and Lasso Selection appears near the top of the results list.

- Click Show Command Location: a red arrow indicates the command in the user interface.
2. Search Commands in Sketch Mode:

- The example below shows how you might use Search Commands to find and run the **Dynamic Mirror** command in the **Sketch Mode**.

- Using the same part, open a **new sketch** on the **side face** of the model as noted.

- Start typing the command **Dynamic Mirror** in Search Commands. As soon as you type the first few letters of the word Dynamic, the results list displays only those commands that include the character sequence "**dyna**," and **Dynamic command** appears near the top of the results list.
- Click **Show Command Location**; a red arrow indicates the command in the user interface.

- Additionally, a Search Shortcut can be assigned to any command to help find it more quickly (see Customize Keyboard in the SOLIDWORKS Help for more info):
  1. Click **Tools / Customize**, and select the **Keyboard** tab.
  2. Navigate to the command to which you want to assign a search shortcut.
  3. In the Search Shortcut column for the command, type the shortcut letter you want to use, then click OK.

- **Save** and close all documents.
Exercise: Extrude Boss & Extrude Cut

NOTE: In an exercise, there will be less step-by-step instruction than those in the lessons, which will give you a chance to apply what you have learned in the previous lesson to build the model on your own.

1. Dimensions are in inches, 3 decimal places.
2. Use Mid-Plane end condition for the Base feature.
3. The part is symmetrical about the Front plane.
4. Use the instructions on the following pages if needed.
1. **Starting with the base sketch:**

- Select the Front plane and open a new sketch.

- Starting at the top left corner, using the line command, sketch the profile below.

- Add the dimensions shown.

- Add the Parallel relation to fully define the sketch.

- Extrude Boss/Base with **Mid Plane** and 3.000” in depth.
2. Adding the through holes:

- Select the face as indicated and click the Normal-To button.

- This command rotates the part normal to the screen.

- The hot-key for this command is Ctrl + 8.

- Open a new sketch and draw a centerline that starts from the origin point.

- Sketch 2 circles on either side of the centerline.

- Add the diameter and location dimensions shown. Push Escape when done.

- Hold the Control key and select both circles and the centerline, then click the Symmetric relation on the properties tree.
- Create an extruded cut using the **Through-All** condition.

3. Adding the upper cut:

- Select the upper face and click the Sketch pencil to open a new sketch.

- Sketch a centerline that starts at the Origin.

- Sketch a rectangle as shown.

- Add the dimensions and relations as indicated.

- Create an extruded cut using the **Up-To-Vertex** condition (up-to-surface also works).

- Select the Vertex indicated.

- Click **OK**.
4. Adding the lower cut:

- Select the lower face of the part and open a new sketch.

- Sketch a rectangle on this face.

- Add a Collinear and an Equal relations to the lines and the edges as noted.

- Extrude a cut using the Through All condition.

5. Adding fillets:

- Select the Fillet command from the Features toolbar.

- Enter .032in. for radius size.

- Select the 4 vertical edges on the inside of the 2 cuts.

- Keep all other options at their default settings.

- Click OK.
6. Adding chamfers:

- Click **Chamfer** under the Fillet button.

- Enter .060 for depth.

- Select the 4 circular edges of the 2 holes.

- Click **OK**.

7. Saving your work:

- Click **File / Save As**.

- Enter **Extrudes_Exe1** for the file name.

- Select a location to save the file.

- Click **Save**.